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QIAGEN Sample and Assay Technologies 
QIAGEN es el principal proveedor de tecnologías innovadoras para muestras y 
ensayos que permiten el aislamiento y la detección del contenido de cualquier 
muestra biológica. Nuestros productos y servicios avanzados de alta calidad 
garantizan el éxito desde la muestra hasta el resultado. 

QIAGEN marca pautas en: 

 Purificación de ADN, ARN y proteínas 

 Ensayos de ácidos nucleicos y proteínas 

 Investigación de microARN y ARNi 

 Automatización de tecnologías para muestras y ensayos 

Nuestro cometido consiste en permitir que nuestros clientes consigan éxitos y 
avances excepcionales. Para obtener más información, visite www.qiagen.com. 
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Contenido del kit 

PyroMark KRAS Kit  (24) 

N.o de catálogo  971450 

Número de reacciones  24 

Seq Primer KRAS 12/13  24 μl 

Seq Primer KRAS 61  24 μl 

PCR Primer KRAS 12/13  24 μl 

PCR Primer KRAS 61  24 μl 

Wt KRAS Control DNA  100 μl 

Mutant KRAS Control DNA  100 μl 

Manual 
 

1 
 

 

Símbolos 

 <N> 
Contiene reactivos para <N> pruebas 

 
Fecha de caducidad 

 
Dispositivo médico para diagnóstico in vitro 

 
Número de catálogo 

 
Número de lote 

 Número de material 

 
Componentes 

 
Contiene 

 
Número 
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Límites de temperatura 

 
Fabricante legal 

 
Consulte la información del manual 

 
Nota importante 

Transporte y conservación 
El PyroMark KRAS Kit se transporta en hielo seco y debe conservarse a –20 °C 
una vez recibido. Evite congelar y descongelar el producto muchas veces (>5). 
El PyroMark KRAS Kit se mantendrá estable hasta su fecha de caducidad si se 
conserva en estas condiciones. 

Indicaciones 
El análisis de las mutaciones del gen KRAS suscita mucho interés en Europa, 
debido a que la Comisión Europea ha autorizado la comercialización 
condicional de panitumumab y cetuximab para el tratamiento del cáncer de 
colon metastásico en pacientes con el gen KRAS no mutado (natural). Esto 
significa que el panitumumab y el cetuximab sólo pueden administrarse a 
pacientes en los que se ha determinado el estado mutacional del KRAS.  

El uso indicado tiene como finalidad facilitar a los médicos la identificación de 
los pacientes con cáncer colorrectal que tienen más posibilidades de 
beneficiarse de los tratamientos anti-EGFR, como el panitumumab y el 
cetuximab. El kit está indicado como complemento de otros factores 
pronósticos utilizados actualmente para seleccionar a los pacientes adecuados 
para los tratamientos anti-EGFR sobre la base del estado mutacional de los 
codones 12, 13 y 61 del gen KRAS de los pacientes. Antes de tomar una 
decisión sobre el tratamiento, el médico debe considerar el estado mutacional 
del paciente junto con otros factores patológicos. El tratamiento de los 
pacientes con cáncer no debe basarse únicamente en estado mutacional  
del KRAS. 

El producto está concebido para la determinación cuantitativa de mutaciones 
en los codones 12, 13 y 61 del gen KRAS humano. El producto consta de  
2 ensayos: uno detecta mutaciones en los codones 12 y 13, y el segundo 
detecta mutaciones en el codón 61. Ambos ensayos contienen cebadores de 
PCR específicos y un cebador de secuenciación.  
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Limitaciones del uso del producto 
Los resultados obtenidos con el producto deben interpretarse dentro del 
contexto de todos los datos clínicos y de laboratorio relevantes. 

Este producto sólo puede utilizarlo personal formado especialmente en 
procedimientos de diagnóstico in vitro y en el sistema PyroMark Q24 MDx. 

Se realizaron estudios de validación con ADN humano extraído de muestras de 
tumores fijadas en formol e incluidas en parafina.  

El producto no incluye los materiales necesarios para la purificación de ADN, la 
amplificación por PCR y la preparación de muestras para el análisis 
Pyrosequencing®. El producto se ha validado con productos de purificación de 
ADN y reactivos de PCR de QIAGEN. Utilice los productos de amplificación por 
PCR y purificación de ADN recomendados, que se especifican en las páginas 
14 y 15. 

El producto está concebido para utilizarse únicamente en el sistema PyroMark 
Q24 MDx. 

Para obtener resultados óptimos es necesario seguir estrictamente las 
instrucciones del manual del usuario. La dilución de los reactivos, aparte de la 
forma descrita en este manual, no está recomendada y disminuirá la eficacia 
del producto. 

Debe prestarse atención a las fechas de caducidad y a las condiciones de 
conservación impresas en la caja y en las etiquetas de todos los componentes. 
No utilice componentes caducados o conservados incorrectamente. 

Asistencia técnica 
En QIAGEN estamos muy orgullosos de la calidad y la disponibilidad de nuestro 
servicio de asistencia técnica. El personal de nuestros departamentos de servicio 
técnico incluye científicos experimentados con amplios conocimientos teóricos y 
experiencia práctica en tecnologías para muestras y ensayos, así como en el  
uso de los productos QIAGEN. Si desea hacer alguna pregunta o está 
experimentando alguna dificultad con el PyroMark KRAS Kit o con los productos 
de QIAGEN en general, no dude en ponerse en contacto con nosotros. 

Los clientes de QIAGEN son una importante fuente de información sobre usos 
avanzados o especializados de nuestros productos. Esta información es útil 
para otros científicos, así como para los investigadores de QIAGEN. Por lo 
tanto, lo animamos a que se ponga en contacto con nosotros si desea hacer 
algún comentario o sugerencia sobre la eficacia del producto o sobre nuevas 
aplicaciones y técnicas. 

Para obtener asistencia técnica y más información, visite nuestro Centro de 
Asistencia Técnica en www.qiagen.com/Support o llame a uno de los 
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departamentos de servicio técnico o a uno de los distribuidores locales de 
QIAGEN (consulte la contraportada o visite www.qiagen.com). 

Control de calidad 
De acuerdo con el sistema de gestión de calidad con certificado ISO de 
QIAGEN, cada lote del PyroMark KRAS Kit se comprueba para verificar que 
cumple las especificaciones predeterminadas a fin de asegurar una calidad 
uniforme del producto. 

Información de seguridad 
Al trabajar con productos químicos, lleve siempre una bata de laboratorio 
adecuada, guantes desechables y gafas protectoras. Para obtener más 
información, consulte las Material Safety Data Sheets (MSDS) (fichas de datos 
de seguridad) adecuadas. Las MSDS de todos los kits y los componentes de los 
kits QIAGEN están disponibles en Internet en formato PDF, práctico y 
compacto, en www.qiagen.com/support/MSDS.aspx, donde se pueden buscar, 
consultar e imprimir. 

Servicio de información de emergencia (disponible 24 horas al día) 

En el siguiente número puede obtenerse información médica de urgencia en 
inglés, francés y alemán 24 horas al día: 

Die Beratungsstelle bei Vergiftungen (Centro de Información Toxicológica) 
Mainz, Alemania 

Tel.: +49-6131-19240 
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Introducción 
El PyroMark KRAS Kit con el marcado CE-IVD permite realizar determinaciones 
cuantitativas de mutaciones en los codones 12, 13 y 61 del gen KRAS humano. 
El producto consta de 2 ensayos: uno para detectar mutaciones en los codones 
12 y 13, y el segundo para detectar mutaciones en el codón 61. Las dos 
regiones se amplifican separadamente por PCR y se secuencian a través de la 
región definida. Las secuencias adyacentes a las posiciones definidas sirven 
como picos de normalización y referencia para la cuantificación y la evaluación 
de la calidad del análisis. 

 
Figura 1. IIlustración del ensayo KRAS. La secuencia indicada es la secuencia analizada 
en una muestra normal. FP y FPB: cebadores anterógrados de PCR (B indica biotinilación);  
RP y RPB: cebadores inversos de PCR (B indica biotinilación); Seq: cebadores de 
secuenciación.  

 Los codones 12 y 13 se secuencian en dirección anterógrada, y el codón 
61, en dirección retrógrada. 

El producto consta de una mezcla de cebadores de PCR y un cebador de 
secuenciación para cada ensayo. Los cebadores se suministran en solución. 
Cada frasco contiene 24 μl de cada cebador o mezcla de cebadores. 

Principios y procedimiento 
El diagrama de flujo de la página 9 ilustra el procedimiento del ensayo. Tras la 
PCR con cebadores dirigidos a los codones 12 y 13 y al codón 61, los 
amplicones se inmovilizan sobre micropartículas Streptavidin Sepharose High 
Performance. Se prepara ADN monocatenario y se hibrida con los cebadores 
de secuenciación correspondientes. A continuación se analizan las muestras en 
el PyroMark Q24 MDx, empleando un archivo de configuración del proceso y 
un archivo del proceso. El parámetro «Sequence to Analyze» (Secuencia a 
analizar) puede ajustarse para la detección de mutaciones infrecuentes después 
del proceso (consulte «Protocolo 6: Análisis de un proceso del PyroMark Q24 
MDx», página 29, y el apéndice A, página 36). 

   Codones 12 y 13 

Codon 61 

Seq 

Seq 

FP 

FPB RPB 

RP 
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Diagrama de flujo del procedimiento PyroMark KRAS 

Configuración del ensayo  
y del proceso 

Preparación de las muestras 

PCR (Protocolo 2) 

 

Configuración del archivo del 
ensayo (Apéndice A) 

 

 

Inmovilización (Protocolo 3)   

 

Configuración del archivo del 
proceso (Protocolo 1) 

Preparación de las muestras 
(Protocolo 4) 

 

 

Proceso del PyroMark Q24 MDx (Protocolo 5) 

 
Análisis del proceso del PyroMark Q24 MDx (Protocolo 6) 

 
Informe 

Eficacia diagnóstica 

Límite del blanco y límite de detección 

Se han determinado el límite del blanco (LDB) y el límite de detección (LDD) 
correspondientes a una serie de mutaciones empleando mezclas de plásmidos 
similares a las suministradas con el kit. Se emplearon dos métodos, 
dependiendo del tipo de mutación. 

 Mutaciones que provocan la aparición de un pico en una posición 
que de otra manera habría estado en blanco: el LDB y el LDD se 
determinaron siguiendo las recomendaciones de la pauta EP17-A del 
NCCLS, «Protocol for determination of limits of detection and limits of 
quantitation; approved guideline» (Protocolo para la determinación de 
límites de detección y límites de cuantificación: pauta aprobada). Los 
errores α- y β- (positivos falsos y negativos falsos, respectivamente) se 
ajustaron a un 5%.  

 La mutación GGT  GTT en el codón 12: esta mutación provoca 
cambios que incluyen picos unitarios y dobles, y no da una respuesta lineal 
a niveles bajos de mutación. Esta posición dio siempre un LDB de 
0 unidades porcentuales (n = 72). La señal más baja que indica la 
presencia de una mutación en esta posición se ajustó a 1 unidad 
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porcentual, lo que está claramente por encima del nivel basal constante de 
0 unidades porcentuales. Al analizar una muestra que contenía una 
mutación de 7 unidades porcentuales, el 95% de los resultados (n = 89) 
dio una señal que pudo considerarse positiva (≥1 unidad porcentual). Por 
lo tanto, el LDD de esta mutación se ajustó a 7 unidades porcentuales, y 
todas las muestras que dieron una señal por encima de 1 unidad 
porcentual se consideraron positivas para esta mutación. 

Tabla 1. LDB y LDD determinados para mutaciones específicas 

Mutación LDB (%) LDD (%) 

ID de 
COSMIC* 

(V42) 

Codón 12 (GGT)    

GAT  0,6 2,2 521 

GTT n.p. 7,0 520 

TGT 0,5 2,1 516 

AGT 0,4 1,9 517 

GCT 0,7 2,3 522 

CGT 0,3 1,8 518 

Codón 13 (GGC)    

GAC 0,3 1,9 532 

Codón 61 (CAA), analizado en orientación inversa (TTG) 

GTG 0,8 2,8 554 

TAG 1,2 3,1 553 

TCG 1,6 3,5 552 

ATG 0,7 2,6 555 

TTC 1,2 3,1 550 
 

* Del Catalogue of Somatic Mutations in Cancer (Catálogo de mutaciones somáticas en el 
cáncer), disponible en la web del Sanger Institute en www.sanger.ac.uk/genetics/CGP/cosmic/. 

n.p.: no procede. 
 

 Estos valores se basaron en procesos en los que la señal fue de más de 
60 RLU, tal como obtiene habitualmente con 10 ng de ADN aislado a partir de 
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tejido fijado en formol e incluido en parafina. Se recomienda confirmar el 
rendimiento del método en el laboratorio. 

Linealidad 

La linealidad se determinó de acuerdo con el documento EP6-A del Clinical 
and Laboratory Standards Institute, «Evaluation of the linearity of quantitative 
measurement procedures: a statistical approach; approved guideline» 
(Evaluación de la linealidad de los procedimientos de determinación 
cuantitativa: un enfoque estadístico; pauta aprobada). 

Se mezclaron secuencias normales y mutantes en proporciones pensadas para 
producir los siguientes niveles de mutación: 0, 12,5, 25, 37,5 y 50%. Se 
colocaron cuatro réplicas de las mezclas formando un patrón aleatorio sobre 
una placa, y se analizaron. Los resultados correspondientes a la mutación  
GGT  TGT en el codón 12 se analizaron con la versión 2.04 del software 
Analyse-it® (Analyse-it Software, Ltd., Reino Unido) y se muestran en la figura 2. 
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Figura 2. Linealidad de la mutación GGT  TGT en el codón 12.  

La repetibilidad global fue de 1,64 unidades porcentuales y los resultados 
fueron lineales dentro de una no-linealidad permisible de un 3%. Los 
resultados correspondientes a la mutación GGC  GAC en el codón 13 fueron 
similares. 
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Imprecisión intermedia 

La determinación de la linealidad de la mutación GGT  TGT en el codón 12 
fue repetida por 3 operadores en 3 días distintos, empleando diferentes 
combinaciones del instrumento PyroMark Q24 MDx y los PyroMark Gold Q24 
Reagents. Los resultados de los 3 procesos se muestran en la tabla 2. 

Tabla 2. Imprecisión intermedia 

 Proceso 1 Proceso 2 Proceso 3 Resumen 

Esperado Media DE Media DE Media DE Media DE 

0,0 0,6 0,2 1,7 0,7 0,7 0,2 1,0 0,6 

12,5 13,3 1,5 16,2 1,9 14,6 3,0 14,7 1,4 

25,0 23,8 1,4 26,8 2,4 26,9 2,9 25,8 1,8 

37,5 42,0 1,9 41,7 0,5 38,5 2,6 40,7 2,0 

50,0 49,7 2,4 50,5 1,8 49,1 4,8 49,8 0,7 
 

Todos los valores están expresados en unidades porcentuales. DE: desviación estándar. 
 
Los valores correspondientes a la imprecisión intermedia (DE) fueron por tanto 
de 0,6-2,0 unidades porcentuales en el intervalo medido de 0-50%. 

Sensibilidad y especificidad diagnósticas 

El PyroMark KRAS Kit se evaluó en un estudio. Se utilizó el DxS Therascreen®: 
K-RAS Mutation Kit para realizar una comparación de los resultados obtenidos 
en 100 muestras prospectivas de tumores malignos colorrectales analizadas 
para comprobar las mutaciones de los codones 12 y 13.  

El ADN empleado para los análisis se aisló empleando el EZ1 DNA Tissue Kit, y 
los análisis se realizaron con el PyroMark KRAS Kit en el PyroMark Q24 MDx y 
con el Therascreen: K-RAS Mutation Kit en el ABI PRISM® 7900HT SDS.  

El análisis DxS permitió determinar el estado mutacional de 91 de las 
100 muestras. El análisis Pyrosequencing permitió determinar el estado 
mutacional de los codones 12 y 13 en 94 muestras.  

Si se excluyen las muestras cuyo estado no pudo determinarse con uno o 
ambos kits, la correlación del PyroMark KRAS Kit y el Therascreen: K-RAS 
Mutation Kit fue del 100%. La sensibilidad diagnóstica del PyroMark KRAS Kit 
fue del 100%, y la especificidad diagnóstica fue también del 100% (tabla 3). 
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Tabla 3. Resultados correspondientes a los codones 12 y 13 de las 
muestras prospectivas de tumores malignos colorrectales analizadas 

  Therascreen: K-RAS Mutation Kit 

  Mutante Natural Total 

Mutante 33 0 33 PyroMark 
KRAS Kit 

Natural 0 57 57 
 

Análisis del codón 61 

Se utilizó el PyroMark KRAS Kit para analizar las mismas 100 muestras y 
determinar las mutaciones del codón 61. Sólo una muestra dio una evaluación 
de calidad fallida para el ensayo del codón 61. Esta muestra también falló en 
los ensayos PyroMark y Therascreen de los codones 12 y 13, lo que indica que 
la calidad del ADN era demasiado baja. La mayor tasa de éxito del ensayo del 
codón 61 indica que depende menos de la calidad del ADN que los ensayos 
PyroMark y Therascreen de los codones 12 y 13. Como el ensayo Therascreen 
no comprueba la presencia de mutaciones en el codón 61, no es posible 
realizar una comparación directa de los ensayos. 

En 4 de las 99 muestras se detectaron mutaciones en el codón 61. Tres tenían 
mutaciones frecuentes (CAC, CAT y CTA) en el codón 61, mientras que la 
cuarta muestra tenía mutaciones tanto en el codón 60 (GGT  GGA) como en 
el codón 61 (CAA  AAA).  
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Equipo y reactivos que debe aportar el usuario 
Al trabajar con productos químicos, lleve siempre una bata de laboratorio 
adecuada, guantes desechables y gafas protectoras. Para obtener más 
información, consulte las Material Safety Data Sheets (MSDS) (fichas de datos de 
seguridad) correspondientes, que pueden solicitarse al proveedor del producto. 

 Kit de aislamiento de ADN (consulte «Aislamiento de ADN», página 15) 

 Pipetas (ajustables)* 

 Puntas de pipeta estériles con filtro 

 Microcentrífuga de sobremesa*  

 Reactivos de PCR (el PyroMark KRAS Kit se validó empleando el 
HotStarTaq® Plus Master Mix Kit, n.° de cat. 203643, 203645 ó 203646) 

 Termociclador* y tubos de PCR adecuados 

 Streptavidin Sepharose™ HighPerformance (GE Healthcare, n.° de cat.  
17-5113-01; www.gelifesciences.com)  

 PyroMark Q24 MDx (n.° de cat. 9001513)*† 

 PyroMark Q24 MDx Software (n.° de cat. 9019063)† 

 PyroMark Q24 Plate (n.° de cat. 979301)† 

 PyroMark Q24 Cartridge (n.° de cat. 979302)† 

 PyroMark Q24 MDx Vacuum Workstation (n.° de cat. 9001515 ó 
9001517)*† 

 PyroMark Gold Reagents (n.° de cat. 971802)† 

 PyroMark Binding Buffer (n.° de cat. 979306)† 

 PyroMark Denaturation Solution (n.° de cat. 979307)† 

 PyroMark Wash Buffer, concentrate (n.° de cat. 979308)† 

 PyroMark Annealing Buffer (n.° de cat. 979309)† 

 Mezcladora de placas* para la inmovilización en las micropartículas 

 Bloque de calentamiento* capaz de alcanzar los 80 °C 

 Tiras o placa de PCR de 24 pocillos 

 Tiras de tapas 

 Agua de alta pureza (Milli-Q® 18,2 MΩ x cm o equivalente) 

 Etanol (70%) 

* Asegúrese de que los instrumentos se hayan comprobado y calibrado de acuerdo con las 
recomendaciones del fabricante. 

† Marcado CE-IVD de acuerdo con la Directiva 98/79/CE de la UE. Todos los demás productos 
enumerados no tienen el marcado CE-IVD basado en la Directiva 98/79/CE de la UE. 
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Notas importantes 

Precauciones generales 

 El usuario siempre debe prestar atención a lo siguiente: 

 Utilice puntas de pipeta estériles con filtro. 

 Conserve y extraiga los materiales positivos (muestras, controles positivos y 
amplicones) separados de todos los demás reactivos, y añádalos a la 
mezcla de reacción en unas instalaciones separadas espacialmente. 

 Descongele bien todos los componentes a temperatura ambiente  
(15-25 °C) antes de iniciar un ensayo. 

 Una vez descongelados, mezcle los componentes (pipeteándolos 
repetidamente hacia arriba y hacia abajo, o agitándolos en pulsos cortos 
en un agitador vórtex) y centrifúguelos brevemente. 

Material de muestras 

 Todas las muestras tienen que tratarse como material potencialmente 
infeccioso. 

El material de las muestras es ADN humano extraído de sangre o de muestras 
fijadas en formol e incluidas en parafina.  

 No deben utilizarse muestras de personas que estén en tratamiento con 
heparina. No deben utilizarse muestras de sangre que se hayan recogido en 
tubos que contengan heparina como anticoagulante. La heparina afecta a  
la PCR. 

Aislamiento de ADN 
Se recomienda utilizar los kits de QIAGEN mostrados en la tabla 4 para 
purificar el ADN obtenido de los tipos de muestras humanas indicadas, a fin de 
utilizarlo con el PyroMark KRAS Kit. Purifique el ADN siguiendo las instrucciones 
de los manuales de los kits. 
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Tabla 4. Kits de purificación de ADN recomendados para su uso con el 
PyroMark KRAS Kit 

Material de 
muestras 

Kit de aislamiento de ácidos 
nucleicos 

Número de 
catálogo 

(QIAGEN) 

QIAamp® DNA FFPE Tissue Kit (50) 56404 Tejido incluido en 
parafina EZ1® DNA Tissue Kit (48)* 953034 

Sangre QIAamp DSP DNA Blood Mini Kit† 61104 
 

* Siguiendo el protocolo para el uso con tejido incluido en parafina. El EZ1 DNA Tissue Kit 
está indicado para utilizarse junto con el EZ1 Advanced (n.° de cat. 9001410 ó 9001411) y 
la EZ1 Advanced DNA Paraffin Section Card (n.° de cat. 9018298), con el EZ1 Advanced XL 
(n.° de cat. 9001492 ó 9001493) y la EZ1 Advanced XL DNA Paraffin Section Card (n.° de 
cat. 9018700), o con el BioRobot® EZ1 (n.° de cat. 9000705; que ya no se comercializa) y la 
EZ1 DNA Paraffin Section Card (n.° de cat. 9015862). 

† Marcado CE-IVD de acuerdo con la Directiva 98/79/CE de la UE. 

Controles 

 El producto incluye dos controles positivos. Éstos sirven como controles 
para las reacciones PCR y de secuenciación. El wt KRAS Control DNA contiene 
la secuencia normal del KRAS, y el Mutant KRAS Control DNA contiene 
mutaciones en los 3 codones. Ambos controles tienen bases cambiadas en el 
codón 15 y en el codón 59 para distinguirlos del ADN genómico. Los controles 
pueden incluirse por separado en el análisis o mezclarse en las proporciones 
que se deseen. Las secuencias de los controles se muestran en la tabla 5. 

 Para analizar el Mutant KRAS Control DNA, ajuste la «Sequence to 
Analyze» (Secuencia a analizar) a NGTGRCGTAGGYA, dirigida a la primera 
base del codón 12 (consulte el apéndice A, página 36). 

Tabla 5. Secuencias de los controles 

Control 
Codón 

12 
Codón 

13 
Codón 

15 
Codón 

59 
Codón 

61 

Normal GGT GGC GGT GTA CAA 

Mutado TGT GAC GGT GTA CAC 
 

 

 Además, siempre debe incluirse un control negativo (sin ADN molde). 
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Protocolo 1: Configuración de procesos para el 
PyroMark Q24 MDx 

 Cuestión importante antes de empezar 

 Si es necesario, el LDB puede confirmarse empleando una muestra normal o el 
wt KRAS Control DNA suministrado para generar una placa entera de 
resultados. Para obtener información más detallada, consulte la pauta EP17-A 
del NCCLS, «Protocol for determination of limits of detection and limits of 
quantitation; approved guideline» (Protocolo para la determinación de límites de 
detección y límites de cuantificación: pauta aprobada). 

Antes de empezar 

 Cree una configuración de ensayo como se describe en el apéndice A. Esto 
sólo tiene que hacerse una vez, antes de realizar el ensayo PyroMark KRAS 
por primera vez (consulte el apéndice A, página 36).  

Procedimiento 

1. Haga clic en el icono    de la barra de herramientas.  
Se creará un nuevo archivo de proceso. 

2. Introduzca los parámetros del proceso (consulte el apartado 
«Parámetros de los procesos», a continuación). 

3. Configure la placa añadiendo ensayos para los codones 12 y 13 y para 
el codón 61 a los pocillos correspondientes a las muestras que desee 
analizar. Se recomienda utilizar como controles una muestra negativa 
(sin ADN), y el wt KRAS Control DNA y el Mutant KRAS Control DNA 
suministrados.  

4. Una vez que el proceso se haya configurado y esté listo para llevarse a 
cabo en el PyroMark Q24 MDx: imprima una lista de los volúmenes 
requeridos de mezcla enzimática, mezcla de sustrato y nucleótidos, así 
como la configuración de la placa. Seleccione “Pre Run Information” 
(Información previa al proceso) en el menú «Tools» (Herramientas) y, 
cuando aparezca el informe, haga clic en . Cierre el archivo del 
proceso y cópielo a un lápiz USB (suministrado con el sistema) 
empleando el Explorador de Windows®.  

 La información previa al proceso impresa puede utilizarse como 
plantilla para la configuración de las muestras (consulte «Protocolo 3: 
Inmovilización de productos de PCR en micropartículas Streptavidin Sepharose 
High Performance», página 22). 

Para procesar la placa en el PyroMark Q24 MDx, consulte «Protocolo 5: 
Procesamiento con el PyroMark Q24 MDx», página 27.  
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Parámetros de los procesos 

Run name  
(Nombre del proceso): 

El nombre del proceso se asigna al guardar el 
archivo. Al cambiar el nombre del archivo se cambia 
también el nombre del proceso. 

Instrument method 
(Método del 
instrumento): 

Seleccione el método del instrumento según los 
reactivos y el cartucho que se vayan a utilizar para el 
proceso; consulte las instrucciones suministradas con 
los productos.  

Plate ID  
(Identificador de placa): 

Opcional: introduzca el identificador de la PyroMark 
Q24 Plate.  

Bar code  
(Código de barras): 

Opcional: introduzca un número de código de barras 
para la placa o bien, si tiene un lector de códigos de 
barras conectado al ordenador, ponga el cursor del 
ratón en el cuadro de texto «Barcode» (Código de 
barras) (haciendo clic en el cuadro) y lea el código de 
barras con el lector.  

Reagent ID  
(Identificador de 
reactivos): 

Opcional: Introduzca el número de lote de los PyroMark 
Gold Q24 Reagents que se vayan a utilizar. El número 
de lote está indicado en la etiqueta del producto. 

 Recomendamos introducir el identificador de 
los reactivos para poder rastrear cualquier problema 
inesperado que pueda surgir con ellos. 

Run note  
(Nota del proceso): 

Opcional: introduzca una nota sobre el contenido o 
el propósito del proceso. 

Añada los archivos de los ensayos 

Para añadir un ensayo a un pocillo, puede escoger una de las opciones siguientes: 

 Hacer clic con el botón derecho del ratón en el pocillo y seleccionar «Load 
Assay» (Cargar ensayo) en el menú contextual. 

 Seleccionar el ensayo en el explorador de método abreviado, y hacer clic y 
arrastrar el ensayo al pocillo. 

Los pocillos se codifican con colores según los ensayos que se les asocien. 

Introduzca los identificadores de las muestras y las notas 

Para introducir un identificador de muestra o una nota, seleccione la celdilla e 
introduzca el texto. 

Para modificar un identificador de muestra o una nota, seleccione la celdilla (se 
seleccionará el contenido actual) o haga doble clic en ella. 
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Protocolo 2: PCR utilizando el HotStarTaq Plus 
Master Mix Kit y el PyroMark KRAS Kit  
Este protocolo es para amplificaciones por PCR de una región que contenga el 
codón 12 y el codón 13, y otra amplificación por PCR de una región que 
contenga el codón 61, empleando el PyroMark KRAS Kit. 

 Cuestiones importantes antes de empezar 

 La HotStarTaq Plus DNA Polymerase requiere un paso de activación de 
5 minutos a 95 °C (consulte el Manual de la HotStarTaq Plus PCR). 

 Prepare todas las mezclas de reacción en una zona separada de la 
empleada para la purificación de ADN, la adición del ADN molde a la 
PCR, el análisis de productos de la PCR o la preparación de muestras 
antes del análisis Pyrosequencing. 

 Utilice puntas desechables con filtros hidrófobos para minimizar la 
contaminación cruzada. 

Antes de empezar 

 Antes de abrir los tubos de cebadores de PCR, centrifúguelos brevemente 
para que el contenido se deposite en el fondo de los tubos. 

 Ajuste la concentración del ADN de la muestra, si es necesario, a  
0,4-2 ng/μl. 

Procedimiento 

1. Descongele las soluciones de los cebadores y el ácido nucleico 
molde. 
Mezcle bien los productos antes de utilizarlos. 

2. Prepare una mezcla de reacción para cada conjunto de cebadores 
de PCR como se indica en la tabla 6. 
La mezcla de reacción suele contener todos los componentes para la PCR, 
excepto la muestra. 

Prepare un volumen de mezcla de reacción superior al requerido para el 
número total de ensayos de PCR que se vayan a realizar.  
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Tabla 6. Preparación de una mezcla de reacción para cada mezcla de 
cebadores de PCR 

Componente Volumen/reacción 

HotStarTaq Plus Master Mix, 2x 12,5 μl 

PCR Primer KRAS 12/13 o  
PCR Primer KRAS 61 

1 μl 

Agua de alta pureza 6,5 μl 

Volumen total 20 μl 
 

 

3. Mezcle bien la mezcla de reacción y dispense 20 μl en cada tubo 
de PCR.  
No es necesario mantener los tubos de PCR en hielo, ya que la HotStarTaq 
Plus DNA Polymerase es inactiva a temperatura ambiente. 

4. Añada 5 μl de ADN molde (2-10 ng de ADN genómico) a cada tubo 
de PCR (consulte la tabla 7) y mézclelos bien. 

 Siempre debe incluirse un control negativo (sin ADN molde).  

 Incluya reacciones con wt KRAS Control DNA y Mutant KRAS 
Control DNA como controles positivos (consulte «Controles», página 16). 

Tabla 7. Preparación de la PCR 

Componente Volumen/reacción 

Mezcla de reacción 20 μl 

ADN de la muestra 5 μl 

Volumen total 25 μl 
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5. Programe el termociclador siguiendo las instrucciones del fabricante 
y empleando las condiciones indicadas en la tabla 8. 

Tabla 8. Protocolo cíclico optimizado 

   Comentarios 

Paso de activación 
inicial: 

5 min 95 °C La HotStarTaq Plus DNA 
Polymerase se activa 
mediante este paso de 
calentamiento. 

Ciclo de 3 pasos:    

Desnaturalización 20 s 95 °C  

Hibridación 30 s 53 °C  

Extensión 20 s 72 °C  

Número de ciclos 40   

Extensión final: 5 min 72 °C  
 

 

6. Coloque los tubos de PCR en el termociclador e inicie el programa 
cíclico. 

7. Después de la amplificación, lleve a cabo el «Protocolo 3: 
Inmovilización de productos de PCR en micropartículas Streptavidin 
Sepharose High Performance».  
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Protocolo 3: Inmovilización de productos de PCR en 
micropartículas Streptavidin Sepharose High 
Performance 
Con este protocolo se inmoviliza el ADN molde en Streptavidin Sepharose High 
Performance (GE Healthcare) antes del análisis en el PyroMark Q24 MDx.  

Antes de empezar 

 Deje que todos los reactivos y soluciones requeridos alcancen la 
temperatura ambiente (15-25 °C) antes de empezar. 

Procedimiento 

1. Agite suavemente el frasco que contenga la Streptavidin Sepharose 
High Performance hasta lograr una solución homogénea. 

2. Prepare una mezcla maestra para la inmovilización de ADN según la 
tabla 9. Prepare un volumen un 10% superior al requerido para el 
número total de reacciones que se vayan a realizar. 

Tabla 9. Mezcla maestra para la inmovilización de ADN 

Componente Volumen/muestra 

Streptavidin Sepharose High Performance 2 μl 

PyroMark Binding Buffer 40 μl 

Agua de alta pureza 28 μl 

Volumen total 70 μl 
 

 

3. Añada 70 μl de la mezcla maestra a pocillos de una placa de PCR de 
24 pocillos o a tiras de PCR de la forma predefinida en la 
configuración del proceso (consulte «Protocolo 1: Configuración de 
procesos para el PyroMark Q24 MDx», página 17). 

4. Añada 10 μl del producto de PCR biotinilado obtenido con el 
protocolo 2 a cada pocillo que contenga mezcla maestra de la forma 
predefinida en la configuración del proceso (consulte «Protocolo 1: 
Configuración de procesos para el PyroMark Q24 MDx», página 17). 

 El volumen total por pocillo debe ser de 80 μl después de añadir 
la mezcla maestra y el producto de PCR. 
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5. Selle la placa (o las tiras) de PCR empleando tiras de tapas. 

 Asegúrese de que no puedan producirse fugas entre los pocillos. 

6. Agite la placa de PCR a temperatura ambiente (15-25 °C) durante 
5-10 minutos a 1400 rpm. 

 Durante este paso, prepare la PyroMark Q24 MDx Vacuum 
Workstation para la preparación de las muestras de la forma descrita en el 
Manual del usuario del PyroMark Q24.  

7. Lleve a cabo inmediatamente el «Protocolo 4: Preparación de 
muestras antes del análisis Pyrosequencing con el PyroMark  
Q24 MDx». 

 Las micropartículas de sefarosa sedimentan rápidamente. La 
captura de las micropartículas debe tener lugar inmediatamente después 
de la agitación.  
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Protocolo 4: Preparación de muestras antes del 
análisis Pyrosequencing en el PyroMark Q24 MDx 
Con este protocolo se prepara ADN monocatenario y se hibrida el cebador de 
secuenciación con el molde antes del análisis Pyrosequencing en el PyroMark 
Q24 MDx. 

 Cuestiones importantes antes de empezar 

 Antes de abrir los tubos de cebadores de secuenciación, centrifúguelos 
brevemente para que el contenido se deposite en el fondo. 

 Añada los 2 cebadores de secuenciación diferentes siguiendo el mismo 
patrón predefinido para la placa en la configuración del proceso (consulte 
«Protocolo 1: Configuración de procesos para el PyroMark Q24 MDx», 
página 17), dependiendo de la región del análisis (codones 12 y 13, o 
codón 61).  

Antes de empezar 

 Coloque el PyroMark Q24 Plate Holder sobre un bloque de calentamiento 
a 80 °C para utilizarlo en el paso 17. 

Procedimiento 

1. Diluya una cantidad suficiente de cada cebador de secuenciación, 
Seq Primer KRAS 12/13 y Seq Primer KRAS 61, en PyroMark 
Annealing Buffer tal como se muestra en la tabla 10. 
Prepare un volumen de cebador de secuenciación diluido superior al 
requerido para el número total de muestras que se vayan a secuenciar 
(para el número de muestras + una adicional).  

Tabla 10. Dilución de ejemplo de los cebadores de secuenciación 

Componente Volumen/muestra 
Volumen para 

9 + 1 reacciones 

Seq Primer KRAS 12/13 o 

Seq Primer KRAS 61 
0,8 μl 8 μl 

PyroMark Annealing Buffer 24,2 μl 242 μl 

Volumen total  25 μl 250 μl 
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2. Añada 25 μl del cebador de secuenciación diluido a cada pocillo de 
la PyroMark Q24 Plate de acuerdo con la configuración del proceso 
(consulte «Protocolo 1: Configuración de procesos para el PyroMark 
Q24 MDx», página 17). 

 Guarde uno de los PyroMark Q24 Plate Holders (suministrados 
con la PyroMark Q24 MDx Vacuum Workstation) a temperatura ambiente 
(15-25 °C), y utilícelo como soporte al preparar y mover la placa. 

3. Coloque la placa (o las tiras) de PCR del Protocolo 3 y la PyroMark 
Q24 Plate sobre la mesa de trabajo (consulte la figura 3).  

 Asegúrese de que la placa esté en la misma orientación en la que 
estaba cuando se cargaron las muestras. 

 
Figura 3. Colocación de la placa (o las tiras) de PCR y de la PyroMark Q24 Plate 
en la estación de trabajo de vacío. 

4. Aplique vacío a la herramienta abriendo el interruptor de vacío. 
5. Con cuidado, haga descender las sondas de filtro al interior de la 

placa (o las tiras) de PCR para capturar las micropartículas que 
contienen el molde inmovilizado. Mantenga las sondas en posición 
durante 15 s. Tenga cuidado al levantar la herramienta.  

 Las micropartículas de sefarosa sedimentan rápidamente. Si ha 
pasado más de 1 minuto desde la agitación de la placa (o las tiras), agite 
de nuevo durante 1 minuto antes de capturar las micropartículas. 

6. Transfiera la herramienta a la cubeta que contenga etanol al 70% 
(cubeta 1). Purgue las sondas de filtro durante 5 s. 

7. Transfiera la herramienta a la cubeta que contenga solución de 
desnaturalización (cubeta 2). Purgue las sondas de filtro durante 5 s. 

8. Transfiera la herramienta a la cubeta que contenga tampón de 
lavado (cubeta 3). Purgue las sondas de filtro durante 10 s. 

9. Levante la herramienta hacia arriba y hacia atrás (más allá de la 
vertical de 90°) durante 5 s a fin de vaciar de líquido las sondas de 
filtro (consulte la figura 4). 
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Figura 4. Ilustración de la herramienta de vacío levantada hasta más allá de la 
vertical de 90°. 

10. Mientras mantiene la herramienta sobre la PyroMark Q24 Plate, 
cierre el interruptor de vacío de la herramienta (posición Off 
[Desactivado]). 

11. Suelte las micropartículas en la placa que contenga los cebadores de 
secuenciación, agitando suavemente la herramienta de un lado a 
otro. Deje que las sondas de filtro reposen sobre el fondo de los 
pocillos. 

12. Transfiera la herramienta a la cubeta que contenga agua sin 
nucleasa (cubeta 4) y agite la herramienta durante 10 s. 

13. Lave las sondas de filtro haciéndolas descender hasta sumergirlas 
en agua sin nucleasa (cubeta 5) y aplicando vacío. Purgue las 
sondas con 70 ml de agua sin nucleasa. 

14. Levante la herramienta hacia arriba y hacia atrás (más allá de la 
vertical de 90°) durante 5 s a fin de vaciar de líquido las sondas de 
filtro (consulte la figura 4). 

15. Cierre el interruptor de vacío de la herramienta (posición Off 
[Desactivado]) y coloque la herramienta en la posición de 
aparcamiento (P). 

16. Apague la bomba de vacío. 

 Al final de un día de trabajo, los residuos líquidos y las soluciones 
restantes deben desecharse, y la PyroMark Q24 MDx Vacuum Workstation 
debe inspeccionarse para comprobar si presenta polvo o salpicaduras; 
consulte el apéndice B, página 38. 

17. Caliente la PyroMark Q24 Plate con las muestras a 80 °C durante  
2 minutos empleando el PyroMark Q24 Plate Holder precalentado. 

18. Retire la PyroMark Q24 Plate del portaplacas y deje que las muestras 
se enfríen a temperatura ambiente (15-25 °C) durante al menos  
5 minutos. 

19. Lleve a cabo el «Protocolo 5: Procesamiento con el PyroMark  
Q24 MDx».  
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Protocolo 5: Procesamiento con el PyroMark 
Q24 MDx 
Este protocolo describe la carga de PyroMark Gold Q24 Reagents en el 
PyroMark Q24 Cartridge, y el inicio y la finalización de un proceso en el 
PyroMark Q24 MDx. Para consultar una descripción detallada de cómo se 
configura un proceso, consulte el Manual del usuario del PyroMark Q24. 

 Cuestión importante antes de empezar 

 El informe Pre Run information (Información previa al proceso), que se 
encuentra en el menú «Tools» (Herramientas) en la configuración del 
proceso (consulte «Protocolo 1: Configuración de procesos para el 
PyroMark Q24 MDx», página 17), ofrece información sobre el volumen de 
nucleótidos, enzima y tampón de sustrato necesarios para un ensayo 
específico. 

Procedimiento 

1. Cargue el PyroMark Q24 Cartridge con los volúmenes adecuados de 
nucleótidos, enzima y tampones de sustrato.  

2. Abra la puerta del cartucho e inserte el cartucho de reactivos 
cargado, con la etiqueta mirando hacia fuera. Empuje el cartucho 
hasta introducirlo por completo y, a continuación, empújelo hacia 
abajo. 

3. Asegúrese de que la línea esté visible delante del cartucho y cierre la 
puerta. 

4. Abra el bastidor de sujeción de placas y coloque la placa sobre el 
bloque de calentamiento. 

5. Cierre el bastidor de sujeción de placas y la tapa del instrumento. 
6. Introduzca el lápiz USB (que contenga el archivo del proceso) en el 

puerto USB de la parte delantera del instrumento.  

 No retire el lápiz USB antes de que acabe el proceso. 

7. Seleccione «Run» (Procesar) en el menú principal (utilizando los 
botones  y  de la pantalla) y pulse «OK» (Aceptar). 

8. Seleccione el archivo del proceso utilizando los botones  y  de la 
pantalla.  

 Para ver el contenido de una carpeta, seleccione la carpeta y pulse 
«Select» (Seleccionar). Para volver a la vista previa, pulse «Back» (Anterior). 

9. Una vez seleccionado el archivo del proceso, pulse «Select» 
(Seleccionar) para iniciar el proceso. 
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10. Una vez que finalice el proceso y que el instrumento confirme que el 
archivo del proceso se ha guardado en el lápiz USB, pulse «Close» 
(Cerrar). 

11. Retire el lápiz USB.  
12. Abra la tapa del instrumento. 
13. Abra la puerta del cartucho y retire el cartucho de reactivos 

levantándolo y tirando de él hacia fuera. 
14. Cierre la puerta. 
15. Abra el bastidor de sujeción de placas y retire la placa del bloque de 

calentamiento. 
16. Cierre el bastidor de sujeción de placas y la tapa del instrumento. 
17. Deseche la placa y limpie el cartucho. 
18. Analice el proceso siguiendo el «Protocolo 6: Análisis de un proceso 

del PyroMark Q24 MDx». 
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Protocolo 6: Análisis de un proceso del PyroMark 
Q24 MDx 
Este protocolo describe el análisis de mutaciones de un proceso KRAS 
finalizado, utilizando el PyroMark Q24 MDx Software.  

Procedimiento 

1. Introduzca el lápiz USB (que contenga el archivo del proceso 
finalizado) en el puerto USB del ordenador. 

2. Transfiera el archivo del proceso desde el lápiz USB al directorio 
deseado del ordenador utilizando el Explorador de Windows.  

3. Abra el archivo del proceso en modo AQ del PyroMark Q24 MDx 
Software seleccionando «Open» (Abrir) en el menú «File» (Archivo) o 
haciendo doble clic en el archivo ( ) en el explorador de método 
abreviado. 

4. Para analizar el proceso y obtener una visualización general de los 
resultados, haga clic en uno de los botones de análisis. 

 Analizar todos los pocillos. 

 Analizar el pocillo seleccionado. 

Los resultados de los análisis (frecuencias de alelos) y la evaluación de la 
calidad se muestran encima de la posición variable en el pirograma. Para 
obtener más detalles sobre cómo analizar un proceso, consulte el Manual 
del usuario del PyroMark Q24. 

5. Para generar un informe, seleccione Full Report (Informe completo) 
en la opción «Reports for AQ runs» (Informes de procesos AQ) del 
menú. 

 Las mutaciones más frecuentes del KRAS se encuentran en el 
nucleótido 35 (segunda base del codón 12). Por lo tanto, la «Sequence to 
Analyze» (Secuencia a analizar) estándar definida en la Analysis Setup 
(Configuración del análisis) prevé la determinación de mutaciones en esta 
posición (consulte el apéndice A, página 36). Si una muestra contiene una 
mutación en el nucleótido 34 (primera base del codón 12), la «Sequence to 
Analyze» puede cambiarse para analizar también el estado mutacional de 
esta posición, tal como se describe en el apéndice A.  

Las frecuencias actualizadas de las mutaciones del gen KRAS humano en 
los codones 12 y 13 y en el codón 61 se pueden obtener en la web del 
Sanger Institute www.sanger.ac.uk/genetics/CGP/cosmic/.  

 Para obtener resultados fiables, recomendamos alturas de pico 
unitarias de más de 30 RLU. En la configuración del ensayo, la «required 
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peak height for passed quality» (altura de pico requerida para la 
aprobación de la calidad) debe ajustarse a 30 RLU (consulte el apéndice A 
y el Manual del usuario del PyroMark Q24). 

 El informe de resultados Análisis AQ debe utilizarse para 
documentar la cuantificación de alelos. Las cifras mostradas en el 
pirograma están redondeadas y no muestran la cuantificación exacta.  

 Reanálisis de muestras sin mutación detectada en el nucleótido 35 
o con evaluación de calidad «Check» (Comprobar) o «Failed» (Fallida) 

Recomendamos encarecidamente reanalizar todas las muestras sin mutación 
detectada en el nucleótido 35, así como las muestras que obtengan una 
evaluación de calidad «Check» (Comprobar) o «Failed» (Fallida) con la 
«Sequence to Analyze» (Secuencia a analizar) dirigida a las mutaciones del 
nucleótido 34. Las evaluaciones de calidad «Check» y «Failed» podrían indicar 
un pico de referencia en una posición no esperada para una mutación del 
nucleótido 35. Un pico en cualquiera de 3 primeras dispensaciones muestra 
que hay una mutación presente en el nucleótido 34. 

Para reanalizar y determinar mutaciones del nucleótido 34, vaya a «Analysis 
Setup» (Configuración del análisis) y cambie la «Sequence to Analyze» 
(Secuencia a analizar) de GNTGRCGTAGGYA a NGTGRCGTAGGYA. Pulse el 
botón «Apply» (Aplicar) y haga clic en «To All» (A todas) cuando aparezca la 
ventana «Apply Analysis Setup» (Aplicar la configuración de análisis).  

 Reprocesamiento de muestras para la detección de mutaciones de 
bajo nivel 

Se recomienda encarecidamente incluir una muestra normal en cada proceso, 
para permitir la comparación. Cualquier muestra que muestre una frecuencia 
de mutación superior a la de la posición correspondiente en la muestra normal 
deberá examinarse en relación con la tabla que muestra el límite de detección 
(consulte la tabla 11, página 31). Las muestras también pueden compararse 
entre sí para revelar frecuencias de mutación anormalmente altas. 

Como guía, las muestras que se sospeche que tengan una mutación en el 
intervalo comprendido entre el LDD (tabla 11) y el LDD + 3 unidades 
porcentuales deberán reanalizarse por duplicado junto con una muestra 
normal por duplicado. Si ambos duplicados dan el mismo resultado que el 
análisis original y son visiblemente diferentes del control normal, entonces la 
muestra puede considerarse positiva para la mutación. Tenga en cuenta que 
las decisiones relacionadas con el tratamiento de pacientes de cáncer no deben 
basarse únicamente en el estado mutacional del KRAS. 
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 Si se sospecha la existencia de una mutación GGT  GTT, un resultado 
superior al 1% puede considerarse positivo. Este nivel puede variar 
considerablemente entre réplicas (consulte «Límite del blanco y límite de 
detección», página 9). 

Tabla 11. LDB y LDD determinados para mutaciones específicas 

Mutación LDB (%) LDD (%) 

ID de 
COSMIC* 

(V42) 

Codón 12 (GGT)    

GAT  0,6 2,2 521 

GTT n.p. 7,0 520 

TGT 0,5 2,1 516 

AGT 0,4 1,9 517 

GCT 0,7 2,3 522 

CGT 0,3 1,8 518 

Codón 13 (GGC)    

GAC 0,3 1,9 532 

Codón 61 (CAA), analizado en orientación inversa (TTG) 

GTG 0,8 2,8 554 

TAG 1,2 3,1 553 

TCG 1,6 3,5 552 

ATG 0,7 2,6 555 

TTC 1,2 3,1 550 
 

* Del Catalogue of Somatic Mutations in Cancer (Catálogo de mutaciones somáticas en el 
cáncer), disponible en la web del Sanger Institute en www.sanger.ac.uk/genetics/CGP/cosmic/. 

n.p.: no procede. 
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Resultados representativos 

Los resultados de pirogramas representativos se muestran en las figuras 5-10. 

Figura 5. Pirograma obtenido después del análisis de una muestra con un genotipo 
normal en los codones 12 y 13. 

Figura 6. Pirograma obtenido después del análisis de una muestra con un genotipo 
normal en el codón 61. 

Figura 7. Pirograma obtenido después del análisis de muestras con una mutación 
GGT  GAT en la base 2 del codón 12 (nucleótido 35, indicado con una flecha).  
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Figura 8. Pirograma obtenido después del análisis de muestras con una mutación 
GGT  AGT en la base 1 del codón 12 (nucleótido 34, indicado con una flecha), con 
la «Sequence to Analyze» (Secuencia a analizar) GNTGRCGTAGGYA dirigida a la 
base 2 del codón 12 (nucleótido 35). Un color amarillo indica que esta secuencia es 
inesperada y necesita comprobarse. 

Figura 9. Pirograma y resultado obtenidos después del reanálisis de la muestra de la 
figura 8. La mutación GGT  AGT se reanalizó con la «Sequence to Analyze» 
(Secuencia a analizar) NGTGRCGTAGGYA dirigida a la base 1 del codón 12 
(nucleótido 34).  

Figura 10. Pirograma obtenido después del análisis del Mutant KRAS Control DNA 
con la «Sequence to Analyze» (Secuencia a analizar) NGTGRCGTAGGYA dirigida a la 
primera base del codón 12. 
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Guía para la solución de problemas 
Esta guía de solución de problemas puede ser útil para resolver cualquier 
problema que surja. Para obtener más información, consulte también la 
página «Frequently Asked Questions» (Preguntas frecuentes) en nuestro Centro 
de Asistencia Técnica: www.qiagen.com/FAQ/FAQList.aspx. Los científicos de 
los servicios técnicos de QIAGEN contestarán gustosos a cualquier pregunta 
que usted pueda hacerles sobre la información y los protocolos de este 
manual, o sobre las tecnologías para muestras y ensayos (para obtener 
información de contacto, consulte la contraportada o visite www.qiagen.com). 

  Para resolver problemas generales relacionados con el instrumento, 
consulte el Manual del usuario del PyroMark Q24. 

 Comentarios y sugerencias 

Señales en el control que no contiene el molde (control negativo) 

a) Contaminación entre 
pocillos  La señal de un pocillo se detecta en un 

pocillo adyacente. Evite colocar muestras con 
señales de alta intensidad al lado de pocillos de 
control que no contienen el molde.  

b) Contaminación de la 
PCR  Utilice puntas de pipeta estériles con filtro. 

Conserve y extraiga los materiales tales como 
muestras, plásmidos de control y amplicones 
separadamente de los reactivos de PCR. 

Secuencia deficiente o inesperada 

 Baja calidad del ADN 
genómico  El ADN genómico de baja calidad puede 

hacer que falle la PCR. Analice las muestras de 
PCR empleando una técnica electroforética 
(utilizando, por ejemplo, el sistema QIAxcel® o 
electroforesis en gel de agarosa). 

Resultado «Check» (Comprobar) o «Failed» (Fallido) 

 Mutación infrecuente 
no definida en la 
configuración del 
ensayo 

 Ajuste la secuencia a analizar en la 
configuración del ensayo (consulte el  
apéndice A, página 36) y repita el proceso. 
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 Comentarios y sugerencias 

Fondo alto 

 Conservación 
incorrecta de los 
nucleótidos 

 Conserve los nucleótidos a 2-8 °C. La 
conservación a –20 °C puede producir un 
aumento del fondo. 

Ausencia de señales en los controles positivos (wt KRAS Control DNA y 
Mutant KRAS Control DNA) 

a) Mezcla insuficiente de 
enzima o sustrato para 
todos los pocillos 

 Asegúrese de rellenar el PyroMark Q24 
Cartridge de acuerdo con la «Pre Run 
Information» (Información previa al proceso) del 
menú «Tools» (Herramientas). 

b) Reactivos conservados 
o diluidos 
incorrectamente 

 Prepare los PyroMark Gold Q24 Reagents 
siguiendo las instrucciones suministradas con los 
reactivos. 

Pico del trazador inesperado en la última posición variable 

 Contaminación con 
ADN del plásmido de 
control 

 Los plásmidos de control, wt KRAS Control 
DNA y Mutant KRAS Control DNA, contienen 
una diferencia de secuencia exclusiva que puede 
utilizarse para identificar las señales de los 
controles (consulte «Controles», página 16 y 
“Apéndice A: Configuración de ensayos 
PyroMark KRAS», página 36). Utilice puntas de 
pipeta estériles con filtro. Conserve y extraiga los 
materiales tales como muestras, plásmidos de 
control y amplicones separadamente de los 
reactivos de PCR. 
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Apéndice A: Configuración de ensayos PyroMark 
KRAS 
Antes de procesar el PyroMark KRAS por primera vez, el archivo del ensayo 
debe configurarse de la forma descrita a continuación. 

Procedimiento 

Codones 12 y 13 del KRAS 

1. Configure el ensayo de los codones 12 (posición 2) y 13 (posición 2) 
del KRAS con el PyroMark Q24 MDx Software.  

2. Haga clic en el icono  de la barra de herramientas y seleccione 
«New AQ Assay» (Nuevo ensayo AQ). 

3. Introduzca la siguiente secuencia en «Sequence to Analyze» 
(Secuencia a analizar):  
GNTGRCGTAGGYA 

 Las mutaciones más frecuentes del codón 12 se detectarán en el 
nucleótido 35 (segunda posición). Si hay mutaciones presentes en el 
nucleótido 34 (primera posición) cambie la «Sequence to Analyze» 
(Secuencia a analizar) siguiente secuencia: 
NGTGRCGTAGGYA 

 La posición variable 3 (Y) permite discriminar entre las señales 
derivadas de los plásmidos de control (wt KRAS Control DNA y Mutant 
KRAS Control DNA) y las señales del ADN genómico. Mientras que el ADN 
genómico dará como resultado una C, los plásmidos de control darán 
como resultado una T en la posición variable 3. 

4. Introduzca manualmente la siguiente «Dispensation Order» (Orden 
de dispensación):  
TACGACTCAGATCGTAGTC 

TT AA CC GG AA

5

CC TT CC AA GG

10

AA TT CC GG TT

15

AA GG TT CC
0

1

2

 
Figura 11. Histograma de los codones 12 (nucleótido 35) y 13 (nucleótido 38) con 
la «Sequence to Analyze» (Secuencia a analizar) GNTGRCGTAGGYA. 
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TT AA CC GG AA

5

CC TT CC AA GG

10

AA TT CC GG TT

15

AA GG TT CC
0

1

2

 
Figura 12. Histograma de los codones 12 (nucleótido 34) y 13 (nucleótido 38) con 
la «Sequence to Analyze» (Secuencia a analizar) NGTGRCGTAGGYA. 

5. Haga clic en la ficha «Analysis Parameters» (Parámetros del análisis) 
y aumente el «Peak Height Threshold - Required peak height for 
Passed quality:» (Umbral de altura de pico - Altura de pico requerida 
para la aprobación de la calidad:) a 30. 

6. Haga clic en el icono  de la barra de herramientas y guarde el 
ensayo como KRAScodon 12+13. 

Codón 61 del KRAS 

7. Haga clic en el icono  de la barra de herramientas y seleccione 
«New AQ Assay» (Nuevo ensayo AQ). 

8. Introduzca la siguiente secuencia en «Sequence to Analyze» 
(Secuencia a analizar): CTCDTGACCTRC 

 La posición variable 2 (R) permite discriminar entre las señales 
derivadas de los plásmidos de control (wt KRAS Control DNA y Mutant 
KRAS Control DNA) y las señales del ADN genómico. Mientras que el ADN 
genómico dará como resultado una G, los plásmidos de control darán 
como resultado una A en la posición variable 2. 

9. Añada manualmente el siguiente «Dispensation Order» (Orden de 
dispensación): GCTCAGTCAGACTAG 

GG CC TT CC AA

5

GG TT CC AA GG

10

AA CC TT AA GG

15

0

1

2

 
Figura 13. Histograma del codón 61 (nucleótido 183). 

10. Haga clic en la ficha «Analysis Parameters» (Parámetros del análisis) 
y aumente el «Peak Height Threshold - Required peak height for 
Passed quality:» (Umbral de altura de pico - Altura de pico requerida 
para la aprobación de la calidad:) a 30. 

11. Haga clic en el icono  de la barra de herramientas y guarde el 
ensayo como KRAScodon 61.  
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Apéndice B: Vaciado del recipiente de residuos y de 
las cubetas 
 ADVERTENCIA 

 

Productos químicos peligrosos 

La solución de desnaturalización empleada con la estación 
de trabajo de vacío contiene hidróxido sódico, que es 
irritante para los ojos y la piel. 

Utilice siempre gafas de seguridad, guantes y una bata de 
laboratorio.  

La entidad responsable (p. ej., el encargado del 
laboratorio) debe tomar las precauciones necesarias para 
asegurar que el lugar de trabajo circundante sea seguro y 
que los operadores de los instrumentos no se expongan a 
niveles peligrosos de sustancias tóxicas (productos químicos 
o biológicos), tal como se definen en las Material Safety 
Data Sheets (MSDS) (fichas de datos de seguridad) o en los 
documentos de la OSHA,* la ACGIH† o el COSHH‡. 

La evacuación de las emanaciones tóxicas y la eliminación 
de los residuos deben cumplir toda la normativa nacional, 
estatal y local de salud y seguridad. 

* OSHA: Occupational Safety and Health Administration (Administración de Salud y Seguridad 
Ocupacional) (Estados Unidos de América) 

† ACGIH: American Conference of Government Industrial Hygienists (Conferencia 
Estadounidense de Higienistas Industriales Gubernamentales) (Estados Unidos de América) 

‡ COSHH: Control of Substances Hazardous to Health (Control de Sustancias Peligrosas para 
la Salud) (Reino Unido) 

 
Asegúrese de que la eliminación de los residuos del laboratorio cumpla la 
normativa medioambiental federal, estatal y local. 

 Cuestión importante antes de empezar 

 Este protocolo requiere agua de alta pureza (Milli-Q 18,2 MΩ x cm, 
www.millipore.com, o equivalente). 

Procedimiento 

1. Asegúrese de que no se aplique vacío a la herramienta de vacío. 
Asegúrese de que el vacío esté cerrado (posición Off [Desactivado]) y 
de que la bomba de vacío esté apagada. 

2. Deseche todos los restos de soluciones que queden en las cubetas. 
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3. Enjuague las cubetas con agua de alta pureza o cámbielas si es 
necesario. 

4. Vacíe el recipiente de residuos. 

 La tapa puede retirarse sin desconectar el tubo. 

5. Si es necesario limpiar la estación de trabajo de vacío (por ejemplo, 
debido a la presencia de polvo o salpicaduras), siga las instrucciones 
del Manual del usuario del PyroMark Q24. 

 

Referencias 
QIAGEN mantiene en Internet una amplia base de datos actualizada de 
publicaciones científicas que emplean productos QIAGEN. El completo 
conjunto de opciones de búsqueda le permitirá encontrar los artículos que 
necesite, bien mediante una sencilla búsqueda por palabras clave, o bien 
especificando la aplicación, área de investigación, título, etc. 

Si desea consultar una lista completa de referencias, visite la base de datos de 
referencia en la web de QIAGEN en www.qiagen.com/RefDB/search.asp o 
póngase en contacto con los servicios técnicos de QIAGEN o con su 
distribuidor local. 
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Información para pedidos 
 

Producto 
 

Índice 
N.° de 

cat. 

PyroMark KRAS Kit (24) Para 24 reacciones en el PyroMark 
Q24 MDx: cebadores de 
secuenciación, cebadores de PCR, wt 
KRAS Control DNA y Mutant KRAS 
Control DNA 

971450 

PyroMark Q24 MDx Plataforma de detección basada en 
secuencias para el análisis Pyro-
sequencing de 24 muestras en paralelo 

9001513 

PyroMark Q24 MDx 
Vacuum Workstation 

Estación de trabajo de vacío (220 V) 
para preparar 24 muestras en 
paralelo, desde el producto de PCR 
hasta el molde monocatenario  

9001515* 
9001517† 

PyroMark Q24 MDx 
Software 

Software de aplicación  9019063 

Accesorios   

PyroMark Q24 Plate 
(100) 

Placa de reacción de secuenciación de 
24 pocillos  

979301 

PyroMark Q24 
Cartridge (3)  

Cartuchos para la dispensación de 
nucleótidos y reactivos  

979302 

PyroMark Gold Q24 
Reagents (5 x 24) 

Para 5 x 24 muestras: mezcla de 
enzima, mezcla de sustrato y nucleótido  

971802 

PyroMark Binding 
Buffer (200 ml) 

Para la unión del producto de PCR 
biotinilado a las micropartículas de 
sefarosa  

979306 

PyroMark Denaturation 
Solution (500 ml) 

Para la desnaturalización del producto 
de PCR bicatenario a ADN molde 
monocatenario  

979307 

PyroMark Wash Buffer, 
concentrate (200 ml) 

Para el lavado del ADN monocatenario  979308 

* Para el resto del mundo (aparte del Reino Unido). 
† Para el Reino Unido. 
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Producto 
 

Índice 
N.° de 

cat. 

PyroMark Annealing 
Buffer (250 ml) 

Para la hibridación del cebador de 
secuenciación a producto de PCR 
monocatenario y para la reacción 
Pyrosequencing 

979309 

PyroMark Vacuum Prep 
Filter Probe (100)  

Sondas de filtro reutilizables para la 
PyroMark Q96 y Q24 Vacuum 
Workstation 

979010 

PyroMark Control 
Oligo 

Para la comprobación de la instalación 
del sistema  

979303 

PyroMark Q24 
Validation Oligo 

Para la confirmación del rendimiento 
del sistema  

979304 

Productos relacionados  

HotStarTaq Plus Master 
Mix Kit (250) 

Para 250 reacciones de 20 μl: 3 x  
0,85 ml de HotStarTaq Plus Master Mix 
con 250 unidades de HotStarTaq Plus 
DNA Polymerase en total, 1 x 0,55 ml 
de CoralLoad® Concentrate y 2 x  
1,9 ml de agua sin RNasa 

203643 

HotStarTaq Plus Master 
Mix Kit (1000) 

Para 1000 reacciones de 20 μl: 12 x 
0,85 ml de HotStarTaq Plus Master Mix 
con 1000 unidades de HotStarTaq Plus 
DNA Polymerase en total, 4 x 0,55 ml 
de CoralLoad Concentrate y 8 x 1,9 ml 
de agua sin RNasa 

203645 

HotStarTaq Plus Master 
Mix Kit (2500) 

Para 2500 reacciones de 20 μl: 25 ml 
de HotStarTaq Plus Master Mix con 
2500 unidades de HotStarTaq Plus 
DNA Polymerase en total, 5,5 ml de 
CoralLoad Concentrate y 2 x 20 ml de 
agua sin RNasa 

203646 

QIAamp DNA FFPE 
Tissue Kit (50) 

Para 50 preparaciones de ADN:  
50 columnas QIAamp MinElute®, 
proteinasa K, tampones y tubos de 
recogida (2 ml) 

56404 
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Producto 
 

Índice 
N.° de 

cat. 

EZ1 DNA Tissue Kit 
(48) 

Para 48 preparaciones: cartuchos de 
reactivos (tejido), puntas desechables 
con filtro, soportes para puntas 
desechables, tubos para muestras  
(2 ml), tubos de elución (1,5 ml), 
tampón G2 y proteinasa K 

953034 

QIAamp DSP DNA 
Blood Mini Kit 

Para 50 preparaciones: minicolumnas 
de centrifugación QIAamp, tampones, 
reactivos, tubos y VacConnectors 

61104 

 

Para obtener información actualizada sobre licencias y exenciones de 
responsabilidad de productos específicos, consulte el manual o el manual del 
usuario del kit QIAGEN correspondiente. Los manuales y los manuales del 
usuario de los kits QIAGEN están disponibles en www.qiagen.com, o pueden 
solicitarse a los servicios técnicos de QIAGEN o a su distribuidor local. 
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Esta página se ha dejado en blanco intencionadamente 

 



 

 

Marcas comerciales: QIAGEN®, QIAamp®, QIAxcel®, BioRobot®, CoralLoad®, EZ1®, HotStarTaq®, MinElute®, Pyrosequencing® (QIAGEN Group);  
ABI PRISM® (Applera Corporation o sus filiales); Analyse-it® (Analyse-it Software, Ltd.); Milli-Q® (Millipore Corporation); Sepharose™ (GE 
Healthcare); Therascreen® (DxS Limited); Windows® (Microsoft Corporation). 

Contrato de licencia limitada 

El uso de este producto implica la aceptación de las siguientes condiciones por parte del comprador o del usuario del PyroMark KRAS Kit: 

1. El PyroMark KRAS Kit puede utilizarse únicamente según las instrucciones del Μanual del PyroMark KRAS Kit y sólo con los componentes 
incluidos en el kit. En virtud de sus derechos de propiedad intelectual, QIAGEN no otorga ninguna licencia para utilizar o incorporar los 
componentes incluidos en este kit con componentes no incluidos en este kit, excepto en las condiciones descritas en el Μanual del PyroMark 
KRAS Kit y en los protocolos adicionales disponibles en www.qiagen.com. 

2. Aparte de las licencias citadas expresamente, QIAGEN no garantiza que este kit y/o su uso no infrinjan los derechos de terceros. 

3. La licencia de uso de este kit y sus componentes es para un solo uso, por lo que el kit no puede reutilizarse, restaurarse ni revenderse. 

4. QIAGEN desautoriza específicamente cualquier otra licencia, expresa o implícita, aparte de las citadas expresamente. 

5. El comprador y el usuario del kit se comprometen a no realizar, ni a permitir realizar a otras personas, acciones que pudieran llevar a actos 
prohibidos por lo anteriormente expresado, ni a facilitar dichos actos. QIAGEN puede hacer cumplir las prohibiciones de este contrato de 
licencia limitada en cualquier tribunal, y recuperará todos los costes de investigación y legales, incluidas las costas, incurridos para hacer 
cumplir este contrato de licencia limitada o cualesquiera de sus derechos de propiedad intelectual relacionados con el kit y/o sus componentes. 

Para obtener información actualizada sobre las condiciones de la licencia, visite www.qiagen.com. 

© 2009 QIAGEN. Reservados todos los derechos. 
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